
Xerox® FreeFlow® Print Server
Przewodnik używania tonera Clear
Wydobądź blask!

Xerox® Color 800/1000 Press
FreeFlow® Print Server
Przewodnik używania tonera bezbarwnego
(Toner Clear)



Zawartość
3 Druk tonerem bezbarwnym

z Xerox® FreeFlow® Print Server

4 Druk tonerem Clear Dry Ink

6 Używanie narzędzi Xerox®

FreeFlow® Print Server

7 Dodawanie nazw kolorów
specjalnych dla tonera Clear

8 Podpowiedzi i wskazówki

10 Ustawienia pliku InDesign
dla tonera Clear Dry Ink

12 Pomoc dla projektowania prac
z tonerem Clear Dry Ink



Xerox® FreeFlow Print Server Clear Dry Ink - Przewodnik 3

Toner bezbarwny (Clear) – opis ogólny

Standardowo, w każdej maszynie są cztery stacje kolorów – po jednej dla
każdego z kolorów CMYK. Piąta stacja, znajdująca się po prawej stronie,
przeznaczona jest dla opcjonalnego tonera Clear Dry Ink.

Używając tonera Clear Dry Ink możesz:

• Powlekać całą stronę lub dokument – całkowite pokrycie wydruku
uszlachetnia go i poprawia jego wygląd.

• Nakładać warstwy na obiekty lub określone obszary –
toner Clear Dry Ink pozwala tworzyć kreatywne efekty, np.:

– Przyciąganie uwagi do wyróżnionych nagłówków

– Nabłyszczanie fotografii

– Emulacja metalicznego wyglądu za pomocą kolorów kluczowych,
jak np. srebrny, złoty lub miedziany

– Poprawa wyglądu metalicznych obiektów

– Nabłyszczanie grafiki dla wizualnej różnorodności i wyróżnienia na
stronie

– Dodawanie znaków wodnych

Druk tonerem bezbarwnym z kontrolera
Xerox® FreeFlow®Print Server

Łatwo jest drukować tonerem bezbarwnym z kontrolera Xerox® FreeFlow Print
Server i tworzyć w ten sposób powlekanie całej strony lub wybiórcze, stosując te
efekty na plikach klienta.
Oprogramowanie FreeFlow 8.0 SP1 dla maszyn Xerox® Color 800/1000 Press pozwala
Ci również wprowadzać na kontrolerze ustawienia warstw tonera Clear i nadawać
wartość wydrukom. Ten Przewodnik ilustruje proste czynności, które trzeba wykonać na
kontrolerze, aby użyć danych warstw tonera bezbarwnego osadzonych w pliku albo za
pomocą opcji kontrolera FreeFlow. Zawiera również instrukcje dla grafików, pokazujące jak
prawidłowo zaprojektować pliki używające tonera bezbarwnego.
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Opcje druku tonerem Clear
Ustawienia tonera Clear na kontrolerze
FreeFlow® Print Server (wersja 8.0 SP1 i nowsze)
pozwalają używać 4 opcji:

• Użycie osadzonej warstwy Clear (domyślnie)

• Powlekanie całej strony

• Powlekanie obiektu

• Ignorowanie warstwy bezbarwnej

Ustawienia te są dostępne z poziomu kolejki
druku, zadania i strony. Jednorazowo, można
użyć tylko jednej opcji – nie można ich ze sobą
łączyć.

Toner Clear działa ze strumieniami danych:
PostScript, PDF (przez konwersję PostScript)
oraz z innymi plikami PostScriptowymi, np. VIPP®.
W przypadku innych formatów plików, ustawienia
tonera Clear są ignorowane i nie jest on
używany.

1. Użycie osadzonej warstwy Clear – jest to
domyślne ustawienie nowej kolejki druku,
umożliwiające definiowanie warstwy
bezbarwnej przez grafika w pliku. (Przykład A)

• Wybór tej opcji powoduje druk tonerem
bezbarwnym tylko jeśli plik zawiera kolor
specjalny o nazwie Clear.

• Opcja Clear Level nie jest używana i nie da się
jej zmienić (jest szara). Ilość tonera Clear jest
zdefiniowana w pliku.

A B

• To ustawienie działa tak jak wcześniejsze
wersje oprogramowania, które nie miały
ustawień tonera Clear w interfejsie
użytkownika.

2. Powlekanie całej strony (Flood Clear) –
wybór tej opcji sprawia, że warstwa bezbarwna
nakładana jest na całą stronę. Ilość tonera
bezbarwnego jest ustawiana za pomocą
suwaka Clear Level. Opcja Flood Clear
spowoduje nadpisanie i zignorowanie
wszelkich efektów osadzonych w pliku
graficznym, można jednak nanosić warstwę
Flood Clear tylko na określoną stronę lub
strony, a dla pozostałych stron użyć efektów
osadzonych w pliku. (Przykład B)

C D

Drukowanie tonerem bezbarwnym

E
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Sprawdzanie czyopcja Clear
jest zainstalowana
Aby sprawdzić czy opcjonalny toner
Clear jest zainstalowany na kontrolerze
druku, kliknij ikonę Dry Ink Level, która
znajduje się w prawym górnym rogu
ekranu interfejsu kontrolera FreeFlow®

Print Server i sprawdź czy poziom
tonera Clear jest wyświetlany.
Ta funkcja pozwala także sprawdzać
poziomy wszystkich tonerów podczas
produkcji.

3. Powlekanie obiektu (Object Clear) –
ta opcja pozwala nakładać warstwę
bezbarwną na wszystkie obrazy, tekst i/lub
grafikę. (Przykład C)

• Tak jak w opcji Flood Clear, ilość tonera
bezbarwnego jest ustawiana za pomocą
suwaka Clear Level.

• Opcja Object Clear dodaje wartość do zadań
lub stron, które nie mają bezbarwnych
efektów osadzonych przez grafika w pliku.
Opcja nie jest przeznaczona do użycia z pracami,
które zostały wykonane z osadzoną warstwą
Clear, ponieważ efekty w pliku zostałyby
zamienione przez ustawienia kontrolera.

• Jeśli usuniesz zaznaczenie dla wszystkich
obrazów, tekstu i grafiki na ekranie Object
Clear, wyświetli się komunikat błędu
i zostaniesz poproszony o wybranie co najmniej
jednego typu obiektu. (Przykład E)

Uwaga: Domyślnie wybrane są wszystkie
typy.

• Pewne obiekty, które wizualnie wyglądają jak
tekst lub grafika, mogą zostać
skonwertowane na obrazy w programie
graficznym (jest to powszechne np.
w przypadku znaków firmowych). Dla takich
obiektów będą stosowane ustawienia
obrazów / zdjęć.

• Obiekty graficzne to te, które posiadają
zdefiniowane wypełnienie, kontur lub
wygładzenie (albo gradient).

• Wiele obrazów posiada białe obszary tła, np.
zdjęcie samochodu może faktycznie
zawierać samochód na tle białego
prostokąta. W takim przypadku, wybór opcji
Object Clear dla obrazów spowoduje
naniesienie warstwy bezbarwnej na cały
prostokąt, nie tylko na samochód.

4. Ignorowanie (Suppress Clear) – Użyj tej
opcji, aby mieć pewność, że na stronę nie
zostanie nałożona żadna warstwa bezbarwna.
Gdy ta opcja jest zaznaczona, system w ogóle
nie użyje tonera Clear, nawet jeśli plik zawiera
kolor specjalny dla tego tonera. (Przykład D)

Poziom użycia tonera (Clear Level)
Gdy wybrana jest opcja Flood Clear lub Object
Clear, możesz kontrolować ilość nakładanego
tonera Clear. Domyślnie wybrany jest poziom
Maximum, który wywołuje ten sam skutek co
zażądanie 100% koloru specjalnego Clear.
Zapewnia to "maksymalny” efekt.

Inne opcje – niski (Low), średni (Medium) lub
wysoki (High), pozwalają użyć mniejszej ilości
tonera Clear i tworzyć bardziej subtelne efekty.

Suwak Clear Level nie jest używany z opcją użycia
warstwy osadzonej w pliku. W takim przypadku
ilość tonera bezbarwnego jest dla każdego efektu
określana w pliku, przez grafika.
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A

C

W pracach zawierających toner bezbarwny
przydatne może być kilka narzędzi zarządzania,
znajdujących się na kontrolerze druku.

• Aby sprawdzić czy grafik umieścił w pliku
efekty Clear:miniatura Thumbnail wyświetla
efekty na ekranie; sprawdzanie Preflight
identyfikuje żądane kolory specjalne;
zaawansowany podgląd Advanced Preview
wskazuje strony, dla których faktycznie
stosowany jest toner bezbarwny.

• Jeżeli zadanie zostanie wydrukowane
z niespodziewanym kolorem zamiast warstwy
bezbarwnej: Raport błędu wskaże czy w pliku
występuje kolor specjalny, który nie został
rozpoznany.

• Aby sprawdzić czy stosowane jest powlekanie
strony lub obiektu: Zaawansowany podgląd
wskaże strony, dla których używany jest toner
Clear.

Miniatura
Miniatura (Thumbnail) służy do szybkiego
podglądu plików PostScript i PDF. Może być
przydatna do sprawdzania zawartości zadania lub
rozmiaru strony.

Uwaga: Przed wysłaniem zadania do druku,
przycisk Preview w sekcji Print from File (pod
sekcją z nazwą pliku) wyświetla taki sam
podgląd jak funkcja Thumbnail.

W funkcji Thumbnail, plik nie jest jeszcze
zrastrowany i nie są wykorzystywane tabele
barw specjalnych kontrolera druku.
Kolory specjalne są zatem wyświetlane
z użyciem alternatywnej specyfikacji barw
(zobacz str. 8: Jak identyfikowany jest kolor
specjalny?).
Na przykład, demonstracyjne pliki Xerox używają
do wyświetlania zwykle kolor Magenta. Funkcja
Thumbnail pomaga Ci więc łatwo
zidentyfikować obszar nadruku tonera Clear
w pliku zaprojektowanym z efektami nakładania
warstwy bezbarwnej.

Miniatura Thumbnail nie pokaże efektów tonera
bezbarwnego dla opcji Flood Clear lub Object
Clear, ponieważ efekty te dodawane są przez
kontroler (RIP). (Przykład A)

Używanie narzędzi Xerox® FreeFlow® Print Server

Zaawansowany podgląd
Opcje Preview / Advanced Preview rzeczywiście
rastrują plik, w celu pokazania podglądu wydruku.
Zamiast kolorów alternatywnych, używane są
kolory specjalne kontrolera druku.

Każdy efekt Clear zostanie przetworzony jako
piąte rozbarwienie, więc warstwa Clear nie będzie
wyświetlana. (Przykład B)

Opcja Advanced Preview pokazuje jednak czy
toner Clear jest używany na stronie. Obok pól
zaznaczenia C, M, Y, K znajduje się specjalna
ikona – przesuń nad nią kursor myszy, aby
zobaczyć komunikat dla tonera Clear – “On”
(używany) lub “Off” (nieużywany) na stronie.
(Przykład C)

Jeśli obraz w podglądzie Preview / Advanced
Preview wygląda podobnie do Miniatury,
pokazując alternatywny kolor w miejscu gdzie
powinien być toner Clear (tak jak w Miniaturze),
jest bardzo prawdopodobne, że użyta w pliku
nazwa koloru specjalnego nie jest zgodna
z odpowiednikiem z listy nazw tonera Clear na
kontrolerze druku.

Sprawdzanie Preflight
Za pomocą funkcji Preflight możesz sprawdzić
nazwy kolorów specjalnych w zadaniu druku,
które mają reprezentować toner Clear.
W ustawieniach Preflight, upewnij się, że opcja
Spot Colors jest zaznaczona, a następnie
uruchom funkcję Preflight dla Twojego zadania.
Wyświetlony raport pokaże kolory specjalne
i możesz dodać własną nazwę do listy
odpowiedników nazw tonera Clear.

Raport błędów
Jeśli w zadaniu występuje kolor specjalny, który nie
zostanie rozpoznany przez kontroler, zadanie
będzie miało status "Ukończone z ostrzeżeniami",
(tzn., że został wykonany podgląd pokazujący
ostrzeżenia, a nie wydruk). Ostatnia strona
z błędem i komunikatem: Ostrzeżenie: <nazwa
koloru specjalnego> nie jest obsługiwany przez
Pantone nazwa/numer lub nazwa nie występuje
w edytorze kolorów specjalnych. Został użyty
alternatywny kolor pochodzący z aplikacji.

Jeśli opcja “Print Error Page” jest wyłączona lub
używasz podglądu, a nie wydruku, komunikat ten
można przeczytać we właściwościach pracy,
naciskając przycisk “View Report”.

*Przeczytaj rozdział “Dodawanie nazw kolorów specjalnych dla
tonera Clear”.

B
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Dodawanie nazw kolorów specjalnych
dla tonera Clear

Aby umożliwić druk tonerem Clear z kontrolera
Xerox® FreeFlow® Print Server, grafik powinien
przypisać nazwę “Clear” do koloru specjalnego
dla tonera bezbarwnego. “Clear” jest
zdefiniowanym słowem kluczowym, które
kontroler odczytuje jako polecenie “użyj tonera
Clear“.

Ponieważ grafik może użyć własnej nazwy,
kontroler druku umożliwia zarządzanie listą nazw
kolorów specjalnych, które są odpowiednikami
nazwy Clear.

Nazwę koloru specjalnego dla tonera Clear
może Ci podać Twój klient lub możesz sam go
zidentyfikować za pomocą funkcji Preflight.
Po dodaniu nazwy nowego koloru specjalnego do
listy odpowiedników tonera Clear, będzie ona
rozpoznawana w każdym zadaniu.

Tworzenie odpowiednika nazwy
1. Na pulpicie Xerox® FreeFlow Print Server,

zminimalizuj główny ekran i kliknij
dwukrotnie ikonę Set Clear Names.
Otworzy się okno opcji. (Przykłady D i E)

2. Sprawdź czy odpowiednik nazwy już istnieje,
naciskając na klawiaturze 1 i Enter.
Wyświetli się lista istniejących
odpowiedników.

3. Jeśli trzeba dodać nowy odpowiednik nazwy,
naciśnij na klawiaturze 2 i Enter.

4. Wpisz nową nazwę i naciśnij Enter.
Nowa nazwa zostanie dodana do listy
odpowiedników.

Uwaga: W nazwach ważna jest wielkość znaków.

Clear nie oznacza tego samego co clear.
W nazwach możesz używać spacji, np. wpisać
nazwę Clear Dry Ink.

Usuwanie odpowiednika nazwy
1. Zminimalizuj główne okno kontrolera

FreeFlow Print Server przyciskiemwprawym
górnym rogu ekranu.

2. Na pulpicie kontrolera Xerox® FreeFlowPrint
Server, kliknij dwukrotnie Set Clear Names.
Otworzy się okno terminala.

3. Sprawdź czy odpowiednik nazwy, który
chcesz usunąć, już istnieje,
naciskając na klawiaturze 1 i Enter.
Wyświetli się lista istniejących
odpowiedników.

4. Aby usunąć odpowiednik, naciśnij na
klawiaturze 3 i Enter.

5. Wprowadź nazwę odpowiednika, który
chcesz usunąć i naciśnij Enter.

Wskazówki

1. Każdy dodany odpowiednik nazwy
zostaje zachowany. Wystarczy taki
odpowiednik dodać do listy kontrolera
tylko raz.

2. Jeśli zadanie z tonerem Clear drukuje się
nieprawidłowo, z alternatywnym kolorem
wmiejscu bezbarwnej powłoki, sprawdź
raport błędów lub użyj sprawdzania
Preflight, aby zidentyfikować nazwę
użytego koloru specjalnego.
Upewnij się, że nazwa odpowiednika
znajduje się na liście kontrolera oraz
sprawdź wielkość liter i spacje w nazwie.

ED
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Xerox® Color 800/1000 Press

Największy efekt występuje w przypadku
elementów umieszczanych na lub obok
jasnych barw.

Równie ważne jest wykończenie papieru. Użyj
matowego lub niezbyt połyskującego papieru
dla uzyskania najlepszych wyników.

Limity tonera: limit dla tonerów CMYK to 240%,
niezależnie czy dodawany jest toner Clear, czy
nie. Limit dla mieszanki CMYK plus Clear to
260%. FreeFlow Print Server automatycznie
dopasowuje poziom tonera Clear do
wbudowanych limitów maszyny, bez
wpływania na kolory CMYK.

Podpowiedzi i wskazówki

Xerox® FreeFlow® Print Server

• Toner Clear działa ze strumieniami danych
PostScript, językami opartymi o PostScript
(np. VIPP) oraz PDF.

• Toner Clear aktualnie nie działa z Adobe
PDF Print Engine.

• Ważne jest, aby graficy stosowali się do zaleceń
zawartych w tym dokumencie, gdy tworzą
efekty przeznaczone do druku tonerem
bezbarwnym.
Jeśli efekty warstw bezbarwnych zostaną
zaprojektowany w sposób używający
przezroczystości PDF, zamiast nadruku
(overprint), wyniki mogą być inne od
oczekiwanych.

• Mieszanie kolorów z warstwą Clear (knockout):

– Jeżeli zadanie zawiera obiekty z warstwą Clear
i w projekcie nie zaznaczono opcji
“overprint”, barwy obszarów pod obiektami
z warstwą Clear będą się z nią mieszać.
Gdy używana jest opcja Suppress Clear,
efekt knockout będzie nadal występować,
ale warstwa bezbarwna nie będzie drukowana.
Opcja Overprint musi być włączona (na
kontrolerze) dla obiektów Clear w pliku, aby
zapobiec efektowi knockout.

Jak jest identyfikowany kolor
specjalny?
W programie graficznym, np. Adobe InDesign,
grafik tworzy kolor specjalny, który zawiera
dwie informacje:

1. Nazwa – dla wygody grafika oraz
umożliwiająca kontrolerowi rozpoznać kolor.

2. Alternatywny / wyświetlany kolor –
wartości kolorów (zwykle CMYK), które mogą
być użyte na ekranie lub na wydruku na
urządzeniu, które nie używa specjalnego
rozpoznawania i przetwarzania barwy.

Demonstracyjne pliki Xerox i instrukcje
projektowania dokumentów zazwyczaj
używają koloru Magenta, jako alternatywnego,
więc mimo że FreeFlow Print Server rozpozna
nazwę “Clear” i użyje tonera bezbarwnego,
kolor Magenta będzie wyświetlany
w popularnych przeglądarkach plików PDF,
jak np. Acrobat Reader oraz w funkcji
Miniatury na kontrolerze FreeFlow Print Server.

Clear Dry InkClear Dry Ink

Kolor wyświetlany
np. w Adobe Acrobat

Clear Dry Ink

Docelowy wydruk
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Druk przykładowego zadania
1. Na kontrolerze FreeFlow® Print Server
wybierz > Print From File > Sample
Jobs > DesignTips-CDI-Xerox800-
1000Presses_12x18_HR.pdf > OK.

Jeśli ten plik nie jest dostępny w folderze
Sample Jobs, przejdź do:

– www.xerox.com i wybierz Support
& Drivers u góry strony.

– Wpisz 800/1000 w polu wyszukiwania
i kliknij Search. Zostaną wyświetlone
wszystkie wyniki dla Xerox®800/1000
Digital Color Press.

– Kliknij link Documentation, który
pojawi się pod opcją Xerox® FreeFlow

Print Server.

Uwaga: Użyj pliku demo 12x18 lub
SRA3, zgodnie z formatem stosowanym
w Twoim regionie .

Opcjonalnie, możesz przejść do podglądu
pliku, naciskając przycisk View (mała
ikona monitora) pod sekcją z nazwą.

2. Wybierz > (zakładkę) Basic Tab > Paper
Stock 12x18 lub SRA3. Ponieważ jest to
plakat, użyj grubszego papieru
z jedwabistym powlekaniem i matowym
wykończeniem, aby uzyskać jak najlepszy
efekt warstwy bezbarwnej.

3. W zakładce jakości druku wybierz > Clear
Options > Use Embedded Clear.
Następnie wybierz > Print.
(Przykład A na stronie 4.)

• Opcja Clear Dry Ink nie działa wraz
z przetwarzaniem Parallel RIP (dotyczy to
oprogramowania 8.0 i 8.0 SP1, ale może
zostać dodana w aktualizacjach lub
nowszych wersjach).

• Warstwy Clear są nakładane na etapie RIP.

– Warstwa Clear nie może być dodana lub
usunięta gdy wykonywany jest dodruk
zapisanego zadania. Ustawienia Clear Dry
Ink są wówczas niedostępne.

– Jeśli ustawienia Clear Dry Ink zostaną
zmienione w przetworzonej pracy, system
ostrzeże użytkownika o konieczności
ponownego przetworzenia RIP.

• Ustawienia tonera Clear dla stron specjalnych
są stosowane do logicznych obrazów (stron
w pliku źródłowym), nie do stron fizycznych
(zadrukowanych stron arkusza).

– Przykład: W 8-stronicowym pliku letter/A4
wykonywana jest impozycja broszury na
dwóch arkuszach 11x17/A3, z użyciem opcji
Flood Clear tylko dla 1. strony. Toner Clear
jest wówczas nakładany tylko na przedniej
okładce broszury.

• Opcja Flood Clear jest stosowana do stron
zrastrowanych; nie zostanie użyta na pustych
stronach, które są generowane przez system.

– Na przykład, jeśli 10-stronicowy plik
letter/A4 ma wykonaną impozycję broszury
o formacie 11x17"/A3, docelowy wydruk
będzie miał 12 stron na 3 arkuszach;
10 zadrukowanych stron będzie miało
powłokę Clear, a 2 puste strony
wygenerowane przez sytem nie.

– Aby puste strony mogły mieć powłokę
Clear, muszą być one dodane do pliku,
a nie być generowane przez system.

• Przetwarzanie danych zmiennych (VI):

– Opcja Use Embedded Clear:
Dzięki buforowaniu, obszary wymagające
nadruku overprint, które znajdują się
pomiędzy wielokrotnie używanymi obrazami
/ formami a zawartością zmienną mogą
spowodować wystąpienie efektu knockout.
Na przykład, zmienny tekst z powłoką Clear,
zaprojektowany jako znak wodny,
spowoduje knockout statycznego,
kolorowego tła (kolorowy zmienny tekst da
ten sam efekt, ale z warstwą Clear
oczekiwania mogą być inne). Każda forma
tła lub aplikacja VI powinna zatem mieć
wykonany proof z użyciem przykładowych
danych, przed podjęciem zobowiązania
produkcji. Aby uniknąć ograniczeń, wyłącz
buforowanie (niedostępne dla form tła).

– Opcje Flood Clear i Object Clear nie mają
ograniczeń związanych z buforowaniem.
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Ustawienia pliku InDesign dla tonera Clear

Ustawienia pliku InDesign dla
druku z tonerem bezbarwnym
1. Dodaj nową warstwę i nadaj jej nazwę

Clear. (Przykład A)

2. Przesuń bezbarwną warstwę na samą górę
w palecie warstw.

3. Dodaj nowy kolor o nazwie Clear.

Ważne: Jest to domyślna nazwa w niektórych
kontrolerach. Bardzo ważne jest używanie tej
samej nazwy we wszystkich Twoich
aplikacjach. W nazwie koloru ważna jest
wielkość znaków. (Przykład B)

4. Ustaw typ koloru jako specjalny (Spot).

5. Ustaw tryb kolorów na CMYK: 0/100/0/0.
Możesz wybrać dowolny kolor procesowy
i ustawić dla niego wartość 100%.

6. Przydziel kolor Clear do do wypełnień
i konturów albo tekstu i kształtów
stworzonych w InDesign i przenieś je
na warstwę bezbarwną.

7. Aby drukować tonerem Clear na obrazach,
tekście lub grafice, włącz opcję overprint,
żeby zapobiec przebijaniu tła (knockout) spod
spodu. Wybierz Window > Attributes >
Overprint Fill i/lub Stroke. (Przykład C)

BA

C

Grafika z Adobe Illustrator
Grafikę wektorowąmożna wklejać do programu
InDesign i drukować ją tonerem bezbarwnym
jako znak wodny lub na kolorach lub zdjęciach.

1. Skopiuj i wklej grafikę z programu Illustrator
do swojego dokumentu Adobe InDesign.

2. Przypisz wypełnienie lub linię do barwy Clear.

3. Przenieś wszystkie bezbarwne obiekty na
warstwę clear.

4. Włącz dla tych obiektów opcję overprint.

Tinty
Tinty powstają w wyniku nałożenia na siebie 2
identycznych obiektów. Obiekty z górnej
warstwy będą drukowane tonerem Clear,
pozwalając na prześwitywanie koloru obiektu
spod spodu.

1. Wklej lub utwórz grafikę wektorową.

2. Dodaj do niej kolor lub tintę.

3. Skopiuj swoją grafikę i wklej w miejscu na
warstwie clear. Ważne jest aby grafika
drukowana tonerem Clear znajdowała się na
warstwie clear.

4. Dodaj kolor Clear z palety kolorów.

5. Wybierz Window > Attributes > Overprint
Fill i/lub Stroke. (Przykład C)

Tworzenie efektów rastrowych
w Adobe Photoshop
Aby wyróżnić obszar obrazu za pomocą
wygładzania krawędzi i/lub wypełnienia
gradientem, dodaj kanał koloru specjalnego
(Spot) dla warstwy Clear w pliku Photoshop.

Zapisz pracę w formacie TIFF lub PSD i umieść ją
w dokumencie InDesign na warstwie clear.

Tworzenie kanału koloru Spot w Photoshop:

1. Otwórz obraz w programie Photoshop.

2. Utwórz nową ścieżkę lub wybierz kształt.

3. Mając wybrane narzędzie kształtu, dodaj nowy
kanał spot channel. (Przykład D)

a. Nazwij nowy kanał Clear lub użyj tej samej
nazwy, która jest używana przez kolor Clear
w programie InDesign.

b. Wybierz Color > M 100% lub kolor wybrany
w programie InDesign.

c. Wprowadź wartość % value, jeśli chcesz.

4. Zapisz jako PSD lub TIFF z wybraną opcją
dołączania koloru specjalnego.

5. Umieść w InDesign na warstwie Clear.

Uwaga: Aby uzyskać podgląd Twojego obrazu
w pliku PDF, wybierz Advanced > Print
Production > Output Preview i kliknij Simulate
Overprinting.

D
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7. Kliknij Ink Manager i upewnij się, że pole
"All Spots to Process" nie jest zaznaczone.
(Przykład G)

8. Kliknij Save Preset i nadaj nazwę. Zalecamy
użyć nazwy Xerox Digital Press Clear.

Sprawdzanie Twojego pliku PDF
1. Otwórz swój PDF w Acrobat® Professional.

2. W głównym menu wybierz:
Advanced > Print Production > Output
Preview. Zaznacz > Simulate Overprinting.

Jeśli Twój plik ma prawidłowe ustawienia,
wszystkie obszary bezbarwne powinny być
widoczne i umieszczone na oddzielnej
warstwie. Przesuwając kursor nad elementy
bezbarwne, powinieneś widzieć procentowy
udział tonera Clear, który zostanie nałożony
w tych miejscach.

Jeśli wskaźnik pokazuje 0%, warstwa Clear nie
została ustawiona prawidłowo.

Podpowiedź: Jeśli plik zawiera obraz rastrowy
z kanałem dla warstwy Clear, nie będzie
możliwy podgląd obrazu w PDF dopóki nie
włączysz funkcji Output Preview i klikniesz
Simulate Overprinting. Widoczny będzie
jedynie obszar przeznaczony do pokrycia
warstwą bezbarwną. Jeśli Twój obszar
bezbarwny jest przezroczysty i widoczny jest
Twój plik, nie został on ustawiony prawidłowo.

Dodawanie warstwy Clear dla
danych zmiennych w VIPP® Pro
Publisher

Użycie warstwy Clear w aplikacjach danych
zmiennych jest obsługiwane przez
oprogramowanie VPP 8.0 SP3 z poziomu klienta
i wymaga FreeFlow® VI Interpreter 8.0d na
serwerze.

VIPP Pro Publisher (VPP) jest wtyczką plug-in
dla Adobe® InDesign (CS3 i nowsze wersje).
Dzięki niej możesz:

• Tworzyć aplikacje zawierające dane zmienne.

• Eksportować te aplikacje do zasobów VI
Container (plik VPC).

• Drukować aplikacje z prędkością produkcyjną
na urządzeniu Xerox® zgodnym z VIPP Pro.

• Przetwarzać plik VPC za pomocą VI Designer,
VI Explorer lub VI PDF Originator.

Ponadto, VPP pozwala grafikowi wykonać to
wszystko bez konieczności uczenia się technik
programowania VIPP lub języka VIPP Pro.
Aby uzyskać więcej informacji na temat
drukowania z VIPP Pro Publisher (VDP), zapoznaj
się z przewodnikiem użytkownika, który jest
dostarczany wraz z oprogramowaniem.
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• Toner Clear sam w sobie dodaje do strony
pewien połysk. Aby zmaksymalizować efekt,
umieszczaj warstwę bezbarwną nad lub obok
obiektów o jasnej barwie.

• Istotny jest również połysk papieru.
Dla uzyskania najlepszych wyników, używaj
papierów matowych, o niskiej jasności.

• Jeśli elementy bezbarwne nie są prawidłowe:

– Sprawdź warstwy. Warstwa bezbarwna
musi być na samej górze, nad innymi.
Wszystkie elementy bezbarwne muszą się
znajdować na tej warstwie, nad wszelkimi
innymi elementami.

– Upewnij się, że do warstwy bezbarwnej
przypisana jest taka sama nazwa we
wszystkich używanych programach.
W nazwach ważna jest wielkość znaków.

• Pokrycie całego obrazu tonerem Clear
wyrówna połysk i poprawi jego głębię.

• Sprawdź plik PDF w podglądzie wydruku
AcrobatPro przed wysłaniem go do drukarni:
Advanced > Print Production > Output
Preview. Zaznacz > Simulate Overprinting.

• Upewnij się, że prawidłowo wykonałeś
wszystkie kroki zapisywania pliku PDF.
(zob. str. 11)

• Jeśli toner bezbarwny zmiesza się z kolorem
obrazu pod nim (knockout), upewnij się, że
zaznaczyłeś nadruk (overprint).

• Jeśli używasz efektów rastrowych, np.
wygładzania krawędzi, itp., użyj tylko metody
Spot Channel, która została opisana na
stronie 10. w tym przewodniku.
Wszelkie inne metody nie są zalecane.

• Jeśli stosujesz warstwę bezbarwną
w programie Photoshop, upewnij się, że
do kanału koloru specjalnego została
przypisana prawidłowa nazwa.
W nazwach istotna jest wielkość znaków
oraz spójność we wszystkich plikach.

• Nie używaj funkcji przezroczystości
w programie do projektowania.

Pomocne wskazówki dla projektowania
z użyciem tonera bezbarwnego


